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How do I follow my course?

To learn how to do the course you must click on the flag of your country in the
'‘Bienvenue au cours de frangais’ of your course, where initial indications
are given.

Bienvenue au cours de francais

Vous trouverez ici des instructions concernant ce cours et les ressources & votre disposition sur cette plateforme

Nous vous recommandons d'étudier une unité par semaine et de suivre I'ordre qui vous est proposé afin de
profiter pleinement de votre formation.

Bon apprentissage |

IMPORTANT : N'oubliez pas d'utiliser une apostrophe (') et non un accent (") si vous utilisez la forme contractée
lorsque vous saisissez une réponse. Veuillez par ailleurs ne pas mettre de point (.) & la fin des mots ou des
phrases que vous écrivez

[
&
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¢,como estudiar
este curso?
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What kind of course do I have?

You can have a general French course.

Can I change my level?

Yes, you just need to send an email request to the following address:
tutoriasonline@cambridgeinstitute.net

In any case, we recommend trying the course within the first fifteen days from
the starting date to ensure you are at the appropriate level. If you need to
change your level, either to a higher or a lower one, you can only request a
single change.

I enter the Cambridge Institute platform, I put my username
and password, but I get an error. What can I do?

Verify that your username and password are exactly as those sentin the electronic
welcome mail. In case you still cannot access your course, you just need to
send an email request to the following address: .
tutoriasonline@cambridgeinstitute.net, or click Log in

on the link ‘Forgotten your username or
password?’, which will respond automatically
by telling you how you should change your

Tsername

username and password. Password Login
Emails received after clicking on ‘Forgotten U Remember username
your username or password?' may come to |F:::'g:t:e:: VOur username or '__'-:.55'.-:=::':iT|

the spam folder so it is advisable to also
check this section of your email account.

Cookies must be enabled in your browser ()
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We recommend you accept cookies from our website

“Cookies” are pieces of information that are stored on your computer and
are used by the browser and the servers of pages visited in order to preserve
information from one page to another. On the platform, “cookies” are necessary
to remember your user name in the browser and to keep the service running
between pages. When you leave the platform or close the browser this cookie
is destroyed. How to enable cookies in some browsers:

1. Windows Internet Explorer — go to Tools > Internet Options >
Privacy (verify that it is marked on Media).

2. Windows Firefox — Go to Tools > Options > Privacy > Cookies and
Accept cookies (verify that the site is marked).

3. Windows Chrome - Go to Settings > Privacy > Content Settings >
Mark Allow local data to be stored.

4. Macintosh Safari — go to Safari > Preferences > Privacy > Cookies
(verify that "Accept Cookies’ is marked).

Go to page 20 of this document (to the section called 'Suggestions’) to
configure cookies depending on your browser.

Can I do the course from my Smartphone or Tablet?

Yes, our courses are designed to be done from smartphones and tablets.
However, it depends on the type of exercise.

Example: 'Enregistrement’ and '‘Drag and Drop’ exercises must be done
directly on the computer as they require Flash.
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I entered the Cambridge Institute platform and put my
username and password, but should I install any software?

All you need is to have Flash Player and JavaScript enabled on your browser
or installed on your computer. Do not forget to restart your browser and your
computer after performing installation so changes are saved (we recommend
to use the latest versions of Flash Player and JavaScript). Download Flash
Player and JavaScript by clicking on the respective links:

|
ADOBE g)
B FLASH PLAYER e
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-[g' Adobe - Install Adobe Fla- %

<« € [ getadobe.com/flashplayer/?na_redirect

Step:1of 3

AdObe Fl.aSh P[ayer Optional offer: Terms & conditions:

Dvesj install the free McAfee Security By clicking the "Install now™ button, you
Scan Plus utility to check the status of acknowledge that you have read and agree
my PC security. It will not modify to the Adobe Software Licensing Agreement.
‘existing antivirus program or PC
settings.

U McAfee® ' Security Scan Plus

Note: Adobe Flash Player i already installed, but
disabled. Click here for mere information. Learn more

Version 15.0.0.189
System requirements

Your system:
Windows 64-bit, English, Chrome
Need Flash Player for a different computer?

Note: Your antivirus software must allow
you to install software.

Are you an IT manager or OEM? Install now

Total size: 17.09 MB

When you install, uninstall or upgrade Flash, (whenever Chrome asks), please
mark: "Always allow JavaScript on elearningcambridge.institute/com-
plete/.

pr o i W WA [

Continue blocking JavaScript

Manage lavaScript blocking... Done

= — e - aa S

If not, check the following page which tells you how to enable Java in each
browser. Just search the one you use.

http://www.enable-javascript.com/
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Can I see units if I access the platform from different
computers?

Yes, you can. But you must be sure to leave the platform once you have
finished. The student just needs to click '‘Logout’ (at the top right of the initial
window).

I completed the first unit of my course yesterday. Now, I
want to go back to that unit’s exercises, can I access it again?

Yes, you can. All you have to do is to access the corresponding unit. All automatic
correction exercises have unlimited attempts, while for ‘Enregistrement’
and ‘Ecrire’ exercises (corrected by your tutor) you are entitled to 5 attempts.

Unité 2

L'AMEUBLEMENT

Ma maison
Une chambre en désordre...
Un nouvel appartement

Les déeménageurs

Who corrects my exercises and essays? How long do I have
to wait for the correction?

All multiple choice questions are automatically corrected by the system and
you can verify the correct answers immediately. Open questions such as
'Enregistrement’ and 'Ecrire’, are corrected in a personalized way by your

tutor within 24 hours - 48 hours.
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Why is the answer marked as incorrect if it is same that the
system gives as correct?

Probably due to the use of accent instead of the apostrophe or the use of
the endpoint, quotation marks, exclamation mark, etc. (please go to the
'‘Bienvenue au cours de francais’ tab for more info).

1. Comment est-ce qu’on dit | en frangais ?

2. Comment est-ce qu'on dit

en francais ?

Why is this message displayed at the end of the exercise:
“Not yet graded”?

Because these exercises are manually corrected by tutors within the next 24-
48 hours.

Started on Tuesday, 15 September 2015, 4:45 PM
State Finished
Completed on Wednesday, 23 September 2015, g:32 PM
Time taken 8days 4 hours
Grade Notvetgraded

Information

A MNpecovc? ot EqniTes
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How can I see the 'Observer et écouter’ audio script?

You need to click 'Observer et écouter’ script as shown in the picture.

Question 2 =
Mot yet answered @L EXERCICE

Marked out of 6.00

v Flag question Ecoutez les phrases. A I'aide des images, écrivez-les :

- Edit question

L

—
Transcription

I cannot see the text of the audio script. What can I do?

Chances are you probably have activated the popup blocker in your browser.
Please disable it and try accessing again. Depending on the browser, a yellow
bar or icon on the top or bottom of your screen and a message in the toolbar
(such as '‘Google Toolbar’) may have appeared. In this case, you must allow

popups for this website. Otherwise, locate the settings for this feature in the
browser you're using.
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How do I record my ‘Enregistrement’ and how do I send it?

Tousetherecordingand upload an audio file you mustfind the ‘Enregistrement’
exercise you have in your course units.

Once here, you must click on the red circle (‘Record’) to start recording.

@l |Zm|:r3 Time: 00:00

Then you click on the white square to stop recording (‘Stop”’) and the file is
automatically sent out showing the next message '‘Uploading’.

If you have not used the microphone before, you may have to allow ‘Camera
and Microphone access’.

In the Chrome browser, Adobe Flash Player will ask you to allow ‘Camera
and Microphone Access’ with a pop-up window, in which you must click
‘Allow’ (if this message does not appear, your microphone may not be
connected).

Adobe Flash Player Settings

Camera and Microphone Access @

elearning.cambridgeinstitute net is
reguesting access to your camera and
miorophone. If you clidk Allow, you may
be recorded.

Bl @ Aow |[& Deny

Subsequently, a message at the top where Chrome will warn you that ‘http://
elearningcambridge.institute/complete/wants to use your camera’,
will appear. You must click ‘Allow”.

€ - C' |[} elearning.cambridgeinstitute.net/course/mod/quiz/attempt.php?attempt=832456

B4 http://elearning.cambridgeinstitute.net/ wants to use your camera. Learn more
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Then, reload the browser page by clicking or pressing e or 'CTRL + R’.
All this can also be done in advance in Chrome.

The first step is to click on the browser icon located in the
top-right of the window. In the dropdown *‘Menu’ you must =&

New tab Cerl+T

click on na 'Settings’. s

ito window  Chrl+ Shift+ N

>

Recent Tabs 13

Edit Cut  Copy  Paste
Save page as... Ctrl+s
Find... Ctl+F
Print. Crri+P
Zoom - 100% -

History CtleH
Downloads Ctrle)

Sign in to Chrome...

T
Once inside, in the 'Privacy’ section click '‘Content settings...’.

Chrome Settings
History Privacy
Extensions -
Content settings... I‘ Clear browsing data... |
I Settings

Google Chrome may use web services to imprave your browsing experience. You may optionally disable these

services, Learn more

About

¥ Use a web service to help resolve navigation errors

Again, once inside the 'Media’ section you can check that everything is in
order.

Content settings

Media
Microphone: Microphone (Realtek ¥
Camera: =

® Ask when a site requires access to your camera and microphone [recommended)

') Do not allow sites to access your camera and microphene

| Manage exceptions... |

10
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I'm trying to do my 'Enregistrement’ exercises but it is not
allowing me to do so, what can I do?

In that case, you must clear the cache of your regular web browser, so the
browser is forced to load the latest versions of web pages. Then, we indicate
how to do it in different browsers.

Chrome:

You must click on the browser icon located in the top right of the window =
In the dropdown menu you must click on ‘More tools’ and 'Clear browsing
data...” in the submenu that appears.

New tab Ctrl+T

New window Ctrl+N
New incognite window  Ctrl+Shift+ N
Bookmarks 3

Recent Tabs >
Edit Cut Copy Paste

Save page as.. Ctrl+S
Find... Ctrl+F
Print... Ctrl+P

Zoom - 1%+ Filee

History CtrleH

Downloads Ctrl+)
Sign in to Chrome...

Settings
About Google Chrome

Create application shertcuts...

Extensions

Task manager

iew source

11
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In the popup window, you must delete the stored items from 'the last 4 week”’
and mark the first four fields before clicking on ‘Clear browsing data’.

E x
Clear browsing data

Psst! Incognito mode (Ctrl+5hift+N) may come in handy next time.

Obliterate the following items fr:nl‘n:| the last 4 weeks = ||

¥ Browsing history

of| Download history

[ Cockies and other site and plug-in data

[ Cached images and files

| Passwords
| Autofill form data

| Hosted app data

Learn maore Clear browsing data | | Cancel |

Saved content settings and search engines will not be cleared and may reflect your

browsing habits.

Mozilla Firefox: oo S

B 4 A 2 e~ 0|
In the upper right corner of the window, click on the _ |
Firefox button and select 'Options”. ik R bl i 2ol

ol 100% +

v B

Mueva venta-  Mueva venta-  Guardar pagi-
na

i

na na privada
re
= O @
v
Imprimir Historial Pantalla com-
pleta
Buscar Opciones Complemen-
tos

Y

Desarrollador

|
| € ricardoroqueromateo@gmail.com
|

Personalizar (7] l:)

12
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Once inside, select the tab or panel called ‘Advanced’.

-
Options

oo B @2 & QT

General Tabs Content  Applications  Privacy  Security Sync Advanced

“lp

Genersl | Data Chaices | Network | Update | Certificates |

Accessibility
[] Ahways use the cursor keys to navigate within pages
[7] Search for text when I start typing

[] Warn me when websites try to redirect or reload the page

Browsing

Use autoscrolling

Use smooth scrolling

Use hardware acceleration when available

Check my spelling as [ type

System Defaults i
Always check to see if Firefox is the default browser on startup

IMake Firefox the default browser

o ) [ome | [ ]

L

Then, click on the tab called ‘Network’ and in ‘Cached Web Content’ within
the 'Clear Now’ section. Then, click '"OK” and restart your browser.

'Options g‘
= ® 3 Qb

General Tabs Content  Applications  Privacy  Security Sync Advanced

GenE:aLI Data Chmcacl Network | UpdatElCertiﬁcatac|

Connection

Configure how Firefox connects to the Internet

Cached Web Content

Your web content cache is currently using 347 MB of disk space

[] Override automatic cache management

Limit cache to 350(5 MB of space

Offline Web Content and User Data
Your application cache is currently using 0 bytes of disk space

Tell me when a website asks to store data for offline use I

The following websites are allowed to store data for offline use:

Remove...

o) (Lo [tee]

13
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Internet Explorer version 9, 10y 11:

In the upper right corner of the window, click on the 'Tools’ button and on
‘Safety’. In the dropdown submenu which appears click on '‘Delete browsing

history...".

+Ti1__ (Gmail
Delete browsing histery... Ctrl+Shift+ Del
InPrivate Browsing Ctrl+Shift+P

Turn on Tracking Protection
Turn off Do Mot Track requests
ActiveX Filtering

Webpage privacy policy...
Check this website

Turn off SmartScreen Filter...

Report unsafe website

Print 4
File »
Zoom (100%) 3
Safety »

Add site to Start menu
View downloads Ctrl+)
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

Report website problems
Internet options

About Internet Explorer

In 'Delete Browsing History’, uncheck
'‘Preserve Favorites website data’ and
keep 'Temporary Internet files and
website files’ and 'Cookies and website
data’, checked before pressing the button
'‘Delete’.

r
Delete Browsing History

[S)

Dprﬁem Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

‘emporary Internet files and website files
Copies of webpages, images, and media that are saved for faster
viewing.

‘ockies and website data
Files or databases stored on your computer by websites to save
preferences or improve website performance.

|:| History
List of websites you have visited.

"] Download History
List of files you have downloaded.

[7] Form data
Saved information that you have typed into forms.

[[] passwords
Saved passwords that are automatically filed in when you signin
to a website you've previously visited.

[7] Tracking Protection, ActiveX Filtering and Do Not Track
A list of websites exduded from filtering, data used by Tracking

about your visit, and exceptions to Do Mot Track requests.

Protection to detect where sites might automatically be sharing details

Delete

I

About deleting browsing history ’ Cancel

l

14
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Safari (Mac 0S):

In the Safari menu click on 'Safari’ and click on 'Private Browsing...” within
the drop-down menu.

File Edit View History
O © About Safari |
- Safari Extensions...

Preferences... 38, |

Private Browsing...
Reset Safari...

Services >
Hide Safari ®H
Hide Others HEH
Show All

Quit Safari ¥0Q

Then, in the popup window, select a time frame and click on 'OK"”.

Do you want to turn on Private Browsing?
Safari can keep your browsing history private. When
you turn on private browsing, Safari doesn't

remember the pages you visit, your search history, or
your AutoFill information.

@ [ Cancel |

To finish cleaning Safari’s cache, click on the reload button &

000 Failed to open page "
al» g + |B google.com ¢ |LReader

15
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I am still having problems with recordings, what can I do?

Another thing you can do is to use a different browser and make sure you have

Flash Player version 10.1 or higher, it is recommended to have it updated.

You can check your version of Flash Player in:

http://helpx.adobe.com/flash-player.html

Visit the following link for solving basic problems related to Java:
http://www.java.com/en/download/help/troubleshoot_java.xml#versios

Delete old versions of Java and restart your computer:

http://www.java.com/en/download/fag/remove_olderversions.xml

Also, when exercising, be sure to use a headset and that speakers are
disconnected, since they cannot be both connected simultaneously.

How do I contact the tutor?
By e-mail to the address:

frenchcourses@institutocambridge.org

16
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Evaluation system

The evaluation system is the sum of all units divided by the total number of
units and multiplied by 0.5, plus the sum of the total test score multiplied by
0.5.

Within your course, you need to click on ‘Grades’, which is located in the right
side of the screen, under '‘Course administration’.

Administration =

¥ Course administration

B [Grades

P My profile settings

Does the online course have any time limit? What is the
deadline to complete my course?

You have limited access to the course, which is specified in the welcome
email sent on the first day of your course, which contains also your passwords
and starting and ending dates of the course. Frames can be:

e 3 months

e 6 months

¢ 9 months

e 12 months

¢ 18 months

17
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The ending date of my course is approaching and I still have
much to do, how can I apply for an extension of time?

Regardless of the reason, a period of no more than 30 days shall be
deemed. For this application, you must write to the following email address:
tutoriasonline@cambridgeinstitute.net

Once this period is over, new extensions will not be granted.

What kind of certificate is given? Do I need to take an exam
to be certified?

A certificate issued by Cambridge Institute is always given if the average of
the entire course and the final exam exceed 60% (in case of examination
in the course). If the course has no final exam, a certificate will be issued if
the average of the entire course exceeds 60%.

I have finished my course, how

do I request my certificate?

Please, access the link:

)

http://gestion.cambridgeinstitute.net/
ecom-ce rtiﬁcate/i ndex. php7|d =3 ‘ CAMBRIDGE INSTITUTE

Heitintiore b deniirie

Follow instructions given.
Is the certificate equivalent to Ella Simonova
DELF or DALF?

No, for a DELF or DALF certificate you
must present yourself to the official
exams.

18
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Suggestions

How do I enable cookies in Chrome browser?

You must click on the browser icon located in the top

| i ‘Settings” = —

right of the window and on 'Settings’ in the drop-down Z
Mew tab Ctri+T

men u . Mew window Ctrl+-N
Mew incognito window  Ctrl+Shift+ N
Bookmarks 3
Recent Tabs 3
Edit Cut Copy Paste
Save page as... Ctrl+5
Find... Ctrl+F
Print... Ctrl+P
Zoom - 100% + ::
History Ctrl+H
Downloads Ctrl+J

Sign in to Chrome...

About Google Chrome

Click on 'Content settings’ within 'Privacy’.

Chrome Settings
History Privacy
Extensions -
Content settings... [ Ciear browsing data... |
| == s | , ,
Google Chrome may use web services to improve your browsing experience. You may optionally disable these

services, Learn more

About

¥ Use a web senvice to help resolve navigation errors

Once inside the 'Cookies’ section mark ‘Allow local data to be set
(recommended)’.

Content settings

Cookies

(. Allow local data to be set (recommended)

./ Keep local data only until you quit your browser
. Block sites from setting any data

["] Block third-party cookies and site data

| Manage exceptions.. || All cookies and site data.. |

19



22& CAMBRIDGE
INSTITUTE

Education Development for a Global Experience

DISTANCE LEARNING PLATFORMS

FAQs (FREQUENTLY ASKED QUESTIONS)

Furthermore, you can click on ‘"Manage exceptions...’. Simply press the button
at the bottom of the previous image and enter the address of Cambridge
Institute in '"Hostname pattern’.

http://elearningcambridge.institute/complete

Cookie and site data exceptions

Hostname pattern Behavior
http://elerning.cambridgeinstitute.net Allow
[*.Jexample.com Allow =

Learn more

Finally, you need to click on '‘Done’ and restart Chrome.

20
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How do I enable cookies in Firefox?

Although Firefox cookies are enabled by default, you can always check and
modify settings if necessary.

We begin by clicking on the top right corner of the window.
Click on the Firefox button and select 'Options”’.

Cut Copy Paste
- 100% +
Mew Window  New Private Save Page
Window
A
=
=
Print History Full Screen
Find Options Add-ons
Developer
€ Signinto Sync
Customize 9 L'J

Once inside, select the tab or panel '‘Privacy’.

'Opﬁcns M‘
0 & B2 0 U

General Tabs Content  Applications = Privacy  Security Sync Advanced

Tracking

(71 Tell sites that [ do not want to be tracked

() Tell sites that I want to be tracked

@ Dg not tell sites anything about my tracking preferences

Learn More

History

Firefox will: | Remember history )

Firefox will remember your browsing, download, form and search history, and
keep cookies from websites you visit.

You may want to clear your recent history, or remove individual cookies.

Location Bar

‘When using the location bar, suggest: | History and Bookmarks ~

[ oK H T ]l Help ]

21
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In the section called 'History’, click on ‘Firefox will’ and mark 'Use custom
settings for history’.
rOpticns g‘

General Tabs Content  Applications ~ Privacy  Security Sync  Advanced

Tracking

() Tell sites that I do not want to be tracked

(71 Tell sites that I want to be tracked

@ Do not tell sites anything about my tracking preferences

Learn More

History

Firefox will: | Remember histol =
Remember history
Never remember history
Use custom settings for history

Firefox will remember your browsing, download, form and search history, and
keep cookies from websites you visit.

You may want to clear your recent histary, or remove individual cookies.

Location Bar

When using the location bar, suggest: | History and Bookmarks ~

[ o H _— ]l Help ]

Once inside, unmark the option called ‘Always use private browsing
mode’ and select these 'Remember my browsing and download history’,
'Remember search and form history’ and 'Accept cookies from sites’.

’

Moreover, make sure that the option called 'Accept third-party cookies
does not contain the value 'Never’. You have two options in '‘Keep until”:

- 'They expire’: cookies will be deleted when they reach expiration date.
- 'I close Firefox’: cookies will be deleted when Firefox is closed.

Do not mark third option: 'Ask me every time’.

22
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rDrn:ions g‘
0 &= o

General Tabs Content  Applications ~ Privacy  Security Sync Advanced

Tracking

Tell sites that I do not want to be tracked

Tell sites that [ want to be tracked
Do not tell sites anything about my tracking preferences

Learn More

History

Firefox will: l Use custom settings for history

[7] Ahways use private browsing mode

Remember my browsing and downleoad history

Remember search and form history

Accept cookies from sites

Accept third-party cookies:
Keep until: Show Cookies...

[7] Clear history when Firefox closes Settings...

Location Bar

When using the location bar, suggest: | History and Bookmarks =

[ ok || concal | [ mHep |

Next, click on ‘Exceptions...’.

4 Ny
Options u

O = B Lk

General Tabs Content  Applications = Privacy  Security Sync Advanced

Tracking

() Tell sites that I do not want to be tracked

() Tell sites that I want to be tracked

@ Dp not tell sites anything about my tracking preferences

Learn More

History

Firefox will: l Use custom settings for history  ~

[T] Always use private browsing mode

Remember my browsing and download history

Remember search and form history

Accept cookies from sites

Accept third-party cookies:
Keep until: | they expire ) Show Cookies...

[T Clear history when Firefox closes Settings...

Location Bar

When using the location bar, suggest: | History and Bookmarks =

[ oK H e H Help I

23
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Once inside '‘Exceptions’ enter the URL for accessing the course in the field
'Address of website’:

http://elearningcambridge.institute/complete

r B
@ Exceptions - Cookies L =[] g

You can specify which websites are always or never allowed to use cookies,
Type the exact address of the site you want to manage and then click Block,
Allow for Session, or Allow.

Address of website:

|http://elerning.cambridgeinstitute.net/course/login|

’ Block ][Alllawforgasi.onli Allow ]

Site Status

Remove Site Remaovwe All Sites Cloze

o 4

Finally click on ‘Allow’ and 'Close’ buttons, then click on 'OK”’ within the
'Privacy’ section, which remained open, and restart Firefox.

24
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How do I enable cookies in Internet Explorer?

Start by marking 'Settings’ # in Internet Explorer, it is in the upper right
part of the window, and then 'Internet options’.

Print

File

Zoom (100%:)
Safety

Add site to Start menu

View downloads Ctrl+)
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

Report website problems

Internet options

Then, click on the 'Privacy’ tab and move the slider to the level of privacy you
want, we recommend ‘Medium’. (as you scroll the slider, Internet Explorer
will offer you a description of the types of cookies that will be blocked and
allowed at each level of privacy).

r Y
Internet Options m

General I Security | Privacy |Conhent | Connections | Programs I Mvanced|

Settings

Select a setting for the Internet zone.
- Blocks third-party cookies that do not have a compact
privacy policy

- Blocks third-party cookies that save information that can
I~ be used to contact you without your explicit consent

- Restricts first-party cookies that save information that
can be used to contact you without your implicit consent

[ Sites ][ Import ][ Advanced ] Default

Location

Never allow websites to request your
O physical location Clear Sites
Pop-up Blocker
Turn on Pop-up Blocker
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

o) Cam ) [
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In addition, press 'Settings’ and once inside, add the Cambridge Institutes
URL within the field that displays the image:

http://elearningcambridge.institute/complete

s B
Internet Options m

| General I Security | Privacy | Content I Connections I Programs I Advanced | rPop-up Blocker Settings g‘
Settings Exceptions
Select a setting for the Internet zone. Pop-ups are cumently blocked. You can allow pop-ups from specffic
Medium ; websites by adding the site to the list below.
- Blocks third-party cookies that do not have a compact Address of website to allow:
privacy palicy http://eleami idgeinstitute.net /course login
- Blocks third-party cookies that save information that can I £ - — S I [ jidd I
=) be used to contact you without your explicit consent
- Restricts first-party cookies that save information that Allowed sites
can be used to contact you without your implict consent Eanere
Remove all..
[ Sites ] [ Import ] [ Advanced ] Default
Location
Mever allow websites to request your
O physical location = =
Pop-up Blocker
ol Notifications and blocking level:
i f el
{rn an Fap-up Blocker Ecitfinas Play a sound when a pop-up is blocked
InPrivate Show Motification bar when a pop-up is blocked
[7] Disable toolbars and extensions when InPrivate Browsing starts Blocking level:
[Madlum Block most automatic pop-ups ']
Leam more about Pop-up Blocker Close
L g

Cancl Aopiy

Finally, click on 'OK”’ and 'Apply’, before restarting Internet Explorer.

g B
Internet Opticns m

| General | Security ‘ Privacy |Conbent | Connections | Programs I Advancedl

Settings

Select a setting for the Internet zone.
Medium

- Blocks third-party cookies that do not have & compact

privacy policy

- Blocks third-party cockies that save information that can
— be used to contact you without your explicit consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

[ Sites ] [ Import. ] [ Advanced I Default
Location

Mever allow websites to request your
D physical location ear s
Pop-up Blocker
Turn on Pop-up Blocker
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

[Lox | e J[_somy ]|
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How do I enable cookies in Safari (Mac 0S)?

In the Safari menu click on 'Safari’ and click on 'Preferences...” within the
drop-down menu.

@ @ About Safari
Safari Extensions...

. & BTN File  Edit  View,
H

Preferences... E

Private Browsing...
Reset Safari...

Services >
Hide Safari ¥H
Hide Others W #H
Show All
Quit Safari $Q
Select the 'Privacy’ tab.
@00 . ; . Privacy

Cookies and other website data: | Remove All Website Data... |

59 websites stored cookies or other data | Details... |

Block cookies and other website data: () From third parties and advertisers
() Always

(*) Never

Limit website access to location services: (®) Prompt for each website once each day
() Prompt for each website one time only
() Deny without prompting

Website tracking: [ | Ask websites not to track me

Smart Search Field: [ | Do not preload Top Hit in the background
[_| Prevent search engine from providing suggestions @;u
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Once inside, in the section called '‘Block cookies and other website data’,
mark ‘Never’ and leave the other options as shown in the following image

@00 Privacy

Cookies and other website data: [ Remove All Website Data... ]
59 websites stored cookies or other data | Details... |

Block cookies and other website data: () From third parties and advertisers
() Always

Limit website access to location services: (®) Prompt for each website once each day
() Prompt for each website one time only
() Deny without prompting

Website tracking: [ | Ask websites not to track me

Smart Search Field: [ | Do not preload Top Hit in the background
[_] Prevent search engine from providing suggestions @

Finally, click on the reload button & in Safari.

ri_ File Edit View History Bookmarks Window Help
Failed to open page e
+ |B google.com ¢ |gReades

For technical questions not mentioned in this manual, you can always contact
Cambridge Institute through this email address:

tutoriasonline@cambridgeinstitute.net
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